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New Features in This Guide

This rewrite of the Impressario User’s Guide supports the 6.5.10 release of applications
for the IRIX operating system.

Documentation Changes

Chapter 3, “Scanning with Impressario,” contains new information about scanning an
image when using a transparency adapter on an HP ScanJet scanner.
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Chapter 1

1. Getting Started With Impressario

Overview of Impressario Tools

Impressario™ provides a full range of tools and drivers for printing, viewing, and
scanning a variety of image types. The product includes or interacts with the following
applications:

Viewing tools

• Use vstiff to view a file and check it for errors before final printing or scanning.
See Chapter 4, “Viewing Files With vstiff.”

Scanning tools

• Use gscan to select, preview, crop, and scan an image from a scanner, a file, or your
monitor’s screen. See Chapter 3, “Scanning With Impressario.”

• Use scanners to add, configure, or remove scanners. This tool is also known as the
Scanner Manager. See “Setting Up an Impressario Scanner” on page 6.

Printing tools

• Use PrintStatus to check which print jobs are in the queue, or delete a print job
from the queue. See “Cancelling a Print Job” on page 14.

The printer icon shows you if the printer is idle, busy, or broken. See
“Understanding the Different Printer Icons” on page 12.

• Use PrintPanel to send a file to a printer, and to choose printer options like
number of copies and paper size. See “Setting Options for Printing Files” on
page 15.

• Use printers to add, configure, or remove printers. This tool is also known as the
Printer Manager. See “Setting Up an Impressario Printer” on page 4.

• Use imprint to convert any text file to PostScript® when you are not using the
PrintPanel. This is a tool for advanced users. See the reference (man) pages for
details.
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Developer software

• Use Impressario’s developer software to create your own scanner and printer
drivers. This is a tool for software programmers.

Built-in Features

• An Adobe Level II PostScript Interpreter.

Note: You must purchase an optional license if you wish to use the Adobe PostScript
interpreter.

• Behind-the-scenes filters that can convert most file types to a format that you can
view or print.

• Sophisticated printer drivers that let you control the printers’ advanced capabilities
through software options panels, and that report up-to-the-minute status on the
printers and print jobs.

Note: scanners, printers, imprint, PrintStatus, and PrintPanel are installed
with your system software. Because Impressario interacts with these tools, they are
included in this overview.

Opening Impressario Tools

Impressario printing and scanning tools appear in your Icon Catalog (see Figure 1-1).

Figure 1-1 Printing Tools in the Icon Catalog
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1. To open the Icon Catalog, choose Find, then “Applications” from your toolchest. See
Figure 1-2 to see an example of the toolchest.

Figure 1-2 Find the Toolchest on Your Desktop

2. Shuffle the pages so you can see the Printing and Scanning group pages. See
“Turning Pages in the Icon Catalog” on page 4 for more details.

3. To open an application, double-click its icon. You can drag any of these icons to your
desktop.

Opening an Application From a UNIX Shell

You can open an application by opening a UNIX® shell from the Desktop toolchest, typing
the application name, and pressing Enter. For information on opening applications
using their icons, see “Opening Impressario Tools” on page 2.

Table 1-1 Summary of Printing and Scanning Application Names

Icon Name Command for UNIX Shell Other Names for Tool

printers printers Printer Manager

PrintStatus printstatus Printer Status Panel

PrintPanel printpanel, glp Printer Panel, glp

imprint imprint none

scanners scanners Scanner Manager

gscan gscan Scanning Tool

vstiff vstiff Viewing Tool
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Turning Pages in the Icon Catalog

The Icon Catalog stores collections of icons on pages. To turn from one page to another,
place the cursor over the tab; then click the left mouse button. You move to that page.

Some of the tabs might not fit in the space provided. When this happens, a stack of
unnamed tabs appears at the left or right edge of the tab display area. To turn to a page
whose tab is hidden:

1. Place the cursor over the stack of unnamed tabs; then press the left mouse button.

2. Choose a page from the menu that appears

Supported Printers and Scanners

For the most current list of supported devices, check the Impressario Release Notes.

If your device is not supported, contact your SGI® representative or your local telesales
representative. A driver may already be available as an add-on product, or a new driver
can be written by following the instructions provided in the Impressario Programming
Guide.

Setting Up an Impressario Printer

Make sure your Impressario printer is listed in “Supported Printers and Scanners” on
page 4,  then set it up by following these steps:

1. Install the Impressario software on the system which you plan to use as the print
server. See the Impressario Release Notes for instructions.

2. If you plan to connect a SCSI printer, shut down your system by choosing “System
Shutdown” from the System toolchest.

3. Set up the printer according to the instructions in the manual that came with the
printer, and connect it to your system (or the network) with the appropriate type of
cable.

Cabling information in the printer manufacturer’s manual and in your owner’s
guide can help you to build or purchase the correct type of cable.
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4. Power on the printer.

Note: Always power on attached SCSI devices before powering on and starting up
your system.

5. If you connected a SCSI printer, power on and restart the system.

6. Use the Printer Manager to add the printer to your list of available printers and to
choose the correct driver for the printer.

■ Start the Printer Manager by choosing “Printer Manager” from the System
toolchest.

■ Choose “Add...” from the Printer menu.

■ Click the OK button. This updates the printer to use the latest Impressario
printer drivers.

7. When the printer is configured, its icon appears in the main window of the Printer
Manager.

Shortcut: To access the printer from the desktop, drag its icon onto the desktop. To
print, drag and drop your file on this printer icon. Double-click the icon to see the
Printer Status Panel.

For a summary of printing capabilities that are available only with Impressario printers,
see Chapter 2, “Printing With Impressario.”

Updating Impressario Printers

When you update or reinstall your Impressario software, you must also update your
previously installed Impressario printers.

Use the Printer Manager to reinstall the printers:

1. Start the Printer Manager by choosing “Printer Manager” from the System
toolchest, or by double-clicking the launch icon.

2. Choose “Change Connection” from the Printer menu.
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3. Click the Help button in the Change Connection window for details on setting up
the printer.

Setting Up an Impressario Scanner

Make sure your scanner is listed in the Impressario Release Notes, then set up your scanner
by following these steps:

1. Install the Impressario software on the system to which you plan to connect the
scanner. See the Impressario Release Notes for instructions.

2. Shut down your system by choosing “System Shutdown” from the System toolchest.

3. Set up the scanner according to the instructions in the manual that came with the
printer, and connect it to your system using a SCSI cable.

Use the cabling information in the scanner manufacturer’s manual and in your
owner’s guide to purchase the correct type and length of SCSI cable.

4. Power on the scanner.

Note: Always power on attached SCSI devices before powering on and starting up
your system.

5. Power on and restart the system, then use the Scanner Manager to add the scanner
to your list of available scanners and to choose the correct driver for the scanner.

■ Start the Scanner Manager by choosing “System Manager” from the System
toolchest and double-clicking the Scanner Manager icon.

■ Choose “Install...” from the Scanner menu.

■ Click the Help button in the Install New Scanner window for details on setting
up the scanner, or see “Setting Up Scanner Software” on page 7.

6. When the scanner is configured, its name appears in the main window of the
Scanner Manager.

For information on scanning using gscan, see Chapter 3, “Scanning With Impressario.”
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Overview of the Scanner Manager

The Scanner Manager lets you:

• Set up system software so you can use a scanner that’s physically connected to your
system or to another SGI system on the network.

• Start gscan, the tool that you use to scan images.

• Set the default scanner, which is the scanner that gscan automatically assumes
you’ll be using when you start gscan from the desktop.

• Delete a scanner from your list of available scanners.

For a list of scanners that Impressario supports, see the Impressario Release Notes.

About the Menus

The Scanner menu contains these choices:

• “Install” lets you set up a new scanner that’s connected to either your own system
or another system on the network.

• “Open” starts gscan using the selected scanner.

• “Delete” removes the selected scanner from the list of available scanners.

• “Default” makes the selected scanner the default scanner. This is the scanner that
gscan will automatically choose each time you open gscan.

• “Quit” stops the Scanner Manager and closes its window.

The Help menu contains a list of help topics. To view a topic, choose it from this menu.

Setting Up Scanner Software

Make sure your scanner is listed in “Supported Printers and Scanners” on page 4,  then
set up the software by following these steps:

1. If the Scanner Manager is not already running, start it by choosing “System
Manager” from the System toolchest and double-clicking the Scanner Manager icon.

2. Choose “Install...” from the Scanner menu.

The Install New Scanner window appears.
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3. Enter a name for the scanner in the New Scanner Name field.

The name can consist of up to 14 characters; no special characters are allowed.

4. Specify whether the scanner is connected to your own system or to another SGI
system on the network.

• Click the box next to Local Host if the scanner is connected to your system.

• Click the box next to Remote Host if it’s connected to another SGI system.

5. Specify which scanner you want to use.

• If this is a local scanner, click to select the correct scanner type from the Scanner
Type list.

The Scanner Manager fills in the Scanner Device field with the SCSI device
information for the scanner that you selected. The Scanner Manager can fill in
this field only if you connected the scanner securely, powered on the scanner
before powering on the system, and selected the correct scanner type from the
list.

If the Scanner Manager does not fill in the field, you can manually enter the
device information. It must be in this form:

/dev/scsi/sc<controller>d<address>l0

Where <controller> is the number of the SCSI controller to which the device is
connected, and <address> is the SCSI address of the device. Note that the last
two characters are the letter “l” and the number zero (0). For example, for a
device with an address of 3 that’s connected to controller number 0, you enter:

/dev/scsi/sc0d3l0

For more information on SCSI devices, see “About SCSI Devices, Controllers,
and Addresses” in Chapter 7 of the Personal System Administration Guide.

• If the scanner you’d like to add is a network scanner, type the name of the SGI
system to which the scanner is connected in the Remote Host Name field, click the
List Scanners button, then click to select a scanner from the Scanner List.

6. Click OK. If the scanner does not install (some scanners may have a SCSI timeout at
this point), then click OK a second time. If there was a timeout, the scanner should
install on the second attempt.

The scanner appears in the list on the main scanners window, and is now ready for use.
To scan an image using this scanner, select the scanner, and choose “Open” from the
Scanner menu. Then use the online help that’s available in the gscan window.
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Deleting a Scanner

To delete an installed scanner:

1. If the Scanner Manager is not already running, start it by double-clicking the launch
icon here, or by choosing “System Manager” from the System toolchest, and
double-clicking the Scanner Manager icon.

2. Click to select the scanner you want to delete.

3. Choose “Delete” from the Scanner menu.

A message box appears to confirm that you really want to delete the scanner.

4. Click OK in the message box.

The scanner is now deleted.

Setting the Default Scanner

You can use the Scanner Manager to specify a default scanner, which is the scanner that
gscan automatically assumes you’ll be using when you start gscan from the desktop.
To use a different scanner for a specific scanning job, choose Scanner Source from
gscan’s Setup menu.

To select a default scanner:

1. If the Scanner Manager is not already running, start it by choosing “System
Manager” from the System toolchest and double-clicking the Scanner Manager icon.

2. Click to select the scanner you want to use as the default.

3. Choose “Default” from the Setup menu.

The selected scanner is now the default scanner.

Starting the Scanning Tool

You can start the scanning tool, gscan, from the Scanner Manager by following these
steps:
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1. If the Scanner Manager is not already running, start it by choosing “System
Manager” from the System toolchest and double-clicking the Scanner Manager icon,
or by double-clicking the scanners icon found in your Icon Catalog.

2. Click to select the scanner from which you want to scan an image.

3. Choose “Open” from the Scanner menu; the gscan window appears.

Use the Help menu for information on using gscan, or see Chapter 3, “Scanning With
Impressario.”
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Chapter 2

2. Printing With Impressario

Impressario lets you:

• Check the status of a printer by viewing the printer’s icon. See “Understanding the
Different Printer Icons” on page 12.

• Cancel a print job. See “Cancelling a Print Job” on page 14.

• Choose a file to print by dragging the file icon onto the printer icon. See “Dragging
and Dropping Files to Print” on page 15.

• Check the status of a print job in the print queue. See “Checking a File’s Status in the
Print Queue” on page 14.

• Set simple and more advanced printing options. See “Setting Options for Printing
Files” on page 15.

• Save printer settings so that all application programs with print commands use the
settings. See “Saving Printer-Specific Options” on page 20.

You can also read about:

• “Setting Up an Impressario Printer” on page 4.

• “Troubleshooting Printing Problems” on page 48.
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Understanding the Different Printer Icons

Open the Printer Manager by choosing it from your System toolchest, or by
double-clicking its icon in your Icon Catalog. Notice that an icon for each available printer
appears in the Printer Manager window.

Shortcut: You can click and drag any of these printer icons onto your desktop. To submit
jobs to the printer, drag a file onto the printer icon. To check the printer’s queue,
double-click the printer icon.

• There are two kinds of printer icons: Impressario and generic. See “Icons for
Impressario and Generic Printers”, below.

• Impressario icons change to reflect your printer’s status. See “Icons That Show the
Printer’s Status” on page 13.

• Impressario icons show you if the printer is PostScript or raster, and if it is color or
black and white. See “Icons for Different Types of Impressario Printers” on page 13.

Icons for Impressario and Generic Printers

Impressario printers have tall, boxy icons. Generic printers have shorter icons with knobs;
see Figure 2-1.

Figure 2-1 Impressario and Generic Printer Icons

• Generic printer icons always appear the same.

• Impressario icons change to reflect your printer’s status. See “Icons That Show the
Printer’s Status” on page 13.

• Impressario icons show you if the printer is PostScript or raster, and if it is color or
black and white. See “Icons for Different Types of Impressario Printers” on page 13.
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Impressario printers are those printers that Impressario supports. Custom printer
drivers and printing options are available for supported printers. See your Impressario
Release Notes for details on supported printers.

Note: If your printer is supported by Impressario, but a generic printer icon appears in
the Printer Manager (instead of an Impressario printer icon), see “Setting Up an
Impressario Printer” on page 4 to reinstall the printer.

Icons for Different Types of Impressario Printers

The piece of paper exiting the top slot of the printer icon describes the printer’s type:
black and white PostScript, color PostScript, black and white raster, or color raster. See
Figure 2-2.

Figure 2-2 Impressario Icons for a Black and White PostScript Printer and a Color Raster
Printer

Icons That Show the Printer’s Status

Only Impressario icons change to show a change in the status of the printer, as shown in
Figure 2-3 and described here:

• An idle Impressario printer icon shows that the printer is not currently printing a job.
The printer named “Impressario” in Figure 2-3 is currently idle.

• A busy Impressario printer icon shows that the printer is currently printing a job.
The printer named “PlainEnglish” in Figure 2-3 is currently busy.
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• A broken Impressario printer icon shows that the printer is unable to print at this
time. For example, it may be out of paper, have a paper jam, or be turned off. The
printer named “BWPostScript” in Figure 2-3 is currently broken.

To see more details on a broken printer, double-click the printer’s icon to see the
PrintStatus window. Look for an error message in the window below Current
Printer Status.

Figure 2-3 Impressario Icons When the Printer is Idle, Busy, and Broken

Cancelling a Print Job

To cancel a print job, open PrintStatus by clicking its icon in your Icon Catalog. Choose
“Cancel Selected Job” from the Queue menu.

Checking a File’s Status in the Print Queue

To check if a file is waiting to be printed:

1. Open PrintStatus by double-clicking its icon in your Icon Catalog.

2. Check the title bar for the correct printer. For example, if your printer is named
“InkJet,” the title bar will read: Printer Status Panel for printer ‘InkJet’.

3. If necessary, change to the Print Status for another printer by choosing “Print Status
for” from the Other Tools menu.

4. Check for your filename in the Printer Request Queue window. Impressario prints
your files in the order that they appear in this queue, starting from the top. Each
filename disappears from the queue after it has been printed.

5. You can check if the printer is idle, busy, or not working by looking at its icon.
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Note: Printers with built-in PostScript only display a busy icon during the time it
takes to transmit the file to the printer (which may only require a few seconds). See
“Icons That Show the Printer’s Status” on page 13.

Dragging and Dropping Files to Print

You can print a file by dragging its icon over a printer’s icon. To do this:

1. Open the Printer Manager from the System toolchest or double-click its icon in your
Icon Catalog.

2. Click and drag a printer icon to your desktop.

3. To print, drag and drop your file on this printer icon.

4. To see the file in the printer’s queue, double-click the printer’s icon. Also see
“Understanding the Different Printer Icons” on page 12.

Setting Options for Printing Files

Set general printing options in the Options frame of the PrintPanel. For Impressario
printers, set printer-specific options by choosing More Options... from the PrintPanel.
See your Impressario Release Notes for a list of Impressario printers.

Tip: To see detailed information on More Options choices, pass your cursor over an item.
A description appears in a frame at the top of the More Options window.

Read about:

• “Changing Printer Settings for All File Types” on page 16.

• “Changing Printer Settings for PostScript Files” on page 16.

• “Changing Printer Settings for Image Files” on page 18.

• “Changing Printer Settings for Text Files” on page 19.

• “Saving Printer-Specific Options” on page 20.
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Note: Any changes you make to the settings apply only to your own print jobs. For
example, if user joe changes any settings, the changes apply only to his print job; user
bob’s print jobs use his own custom settings or the default settings. You can also save any
changes you make so they’ll apply to all subsequent print jobs sent to the same printer.
See “Saving Printer-Specific Options”.

The Administrator can specify default printer settings for all users, but individual users
can override them for their own print jobs; see “Setting Default Printer Options for the
System” on page 43.

Changing Printer Settings for All File Types

General printing settings apply to all three file formats that Impressario supports. They
often include:

Paper Size Specify the size of paper in the printer’s paper tray by clicking the box
next to A (8.5x11-inch), A4 (European A-size) or Legal (8.5x14-inch).

Printer Resolution
Some printers can print at a range of resolutions. The lower the
resolution, the poorer the quality of the printed image.

Print Banner Page
Specify whether to print a banner page as page one of the job. Click in
the Yes box to print the banner page; click in the No box to keep the
printer from printing the banner page.

Verbose Logging
Specify whether to report the details of all printing activity in the
/var/spool/lp/log file. Click in the On box to turn on verbose
logging; click in the Off box to turn it off.

Depending on the printer’s type and model, more general options may be available; for
example, you may be able to specify whether to print in color or in black and white.

Changing Printer Settings for PostScript Files

Find PostScript File Options by clicking on More Options... in the PrintPanel window.
Scroll down until you see PostScript File Options.
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You can change the printer settings for PostScript files and for Text files by changing
PostScript File Options.

Figure 2-4 Change PostScript Settings for PostScript and Text Files

Note: Impressario changes plain text files to PostScript files before printing them out on
either PostScript or raster printers. This is why you can use PostScript File Options to
change the printer settings for plain text files.

Tip: Pass your mouse icon over each option item. Details on each item appear in the top
frame of the More Options window.

PostScript printing options include:

• Page Ordering—Normal prints so page one is the first page of the job; Reversed
makes page one the last page. Click the box next to the option that you prefer.

• Page Range—Lets you print all pages or a subset of pages and, within the range you
select, lets you print only even or only odd pages.

– To print all pages, click the box next to All.

– To print all odd pages in the file, click the boxes next to All and Odd Pages
Only; to print all even pages, click the boxes next to All and Even Pages Only.

– To print a subset of pages, click the box next to From, then type the starting page
and ending page in the fields.

– To print all odd pages within this subset of pages, click the box next to Odd
Pages Only; to print all even pages within the subset, click the box next to Even
Pages Only.
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Changing Printer Settings for Image Files

Find Image File Options by clicking on More Options... in the PrintPanel window. Scroll
down until you see Image File Options.

The options for printing Image files let you control the orientation, darkness, and size of
the printed image. These options apply only to image files.

Figure 2-5 Change Image Settings for SGI Image Files

Tip: Pass your mouse icon over each option item. Details on each item appear in the top
frame of the More Options window.

To change the orientation of the image on the page, change one or more of these settings:

• Mirror Image—Click this box to flip the image horizontally.

• Rotate—Click the box next to Best Fit to automatically rotate and scale the image so
that it is printed as large as possible on the page.

Click the box next to Angle and type in the number of degrees you would like to
rotate the image. The image rotates in a counter-clockwise direction, so typing 90 in
this field rotates the image 90 degrees to the left.

• Darkness—To change the darkness of the image, either slide the bar next to
darkness, or type a value in the field that’s next to the darkness bar. The lower the
darkness value, the lighter the image.

• Scaling—To change the size of the image, change one or more of these Scaling
settings:

– None—Click this box to make the image as large as possible for the specified
paper size.

– Match Input Resolution—The resolution of an image is the number of dots per
inch (dpi) that are in the image.
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To make the printed image the same size as the image on your screen, enter the
resolution of your screen in this field.

To find the resolution of your screen, in a shell window, type:

/usr/bin/X11/xdpyinfo | grep resolution

If your screen’s resolution is 72 dpi, you see this message:

72x72 dots per inch

If your screen’s resolution is 96 dpi, you see this message:

96x96 dots per inch

When printing an image that you originally scanned in, you can match the size
of the image to the original by entering the resolution at which you scanned in
the original.

– Page Fill—Specify what percentage of the printed page your image should
occupy. Impressario scales and centers the image to fit.

Changing Printer Settings for Text Files

Find Text File Options by clicking on More Options... in the PrintPanel window. Scroll
down until you see Text File Options.

The Options window lets you set text file printing options. Click the Yes box next to
Format Text and several options become available.

Figure 2-6 Change Text File Settings for Text Files

Tip: Pass your mouse icon over each option item. Details on each item appear in the top
frame of the More Options window.

To print headers on each page, click the box next to Yes.



20 007-1632-060

2: Printing With Impressario

To change the layout of the text on the page, change these settings:

• Orientation—Click Portrait to orient your text vertically (the way the text of
standard documents is oriented); click Landscape to orient it horizontally.

• Columns Per Page—Click the box next to the number of columns you would like;
all columns are the same width, with approximately a 1/8" margin between them.
Your text will flow from one column to the next.

To change the font style and size, change these settings:

• Font—Click any font that appears in the scrolling list.

• Size—Click any font size.

Saving Printer-Specific Options

The Save button in the PrintPanel window saves two groups of settings:

• The settings in the PrintPanel window, which apply to all printers shown in the list
of available printers. This information is saved in the .glprc file in your home
directory.

• The settings that you change in the Options window for the selected printer (the
printer whose name is highlighted in the Available printers list). These settings are
saved in a file named
/var/spool/lp/settings/<printername>/<username>.

When you save these settings, they apply only to jobs that you submit to the printer; they
do not apply to jobs that other users submit. The Administrator can change system default
settings for a printer, but any user can override these settings for their own jobs; see
“Setting Default Printer Options for the System” on page 43.

To save printer-specific settings, follow these steps:

1. When the settings in the Options window are correct, click the OK or Apply button.

2. In the PrintPanel window, click the Save button.

You see the Save Settings window, which shows a list of all printers whose settings
you have changed during this session with PrintPanel.

3. In the Save Settings window, select the printer(s) whose settings you want to save,
then click the Save button.
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Note: If you are the Administrator, you see two buttons for saving: Save-Personal
saves the settings only for you; Save-All Users saves the settings for all users.

The settings that apply to all printers and the printer-specific options are now saved
and will be in effect the next time you print a job from the desktop or from an
application program.

Now you can either print the file that is specified in the Files to print field by clicking the
Print button, or you can dismiss the PrintPanel window by choosing “Quit” from the File
menu.
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Chapter 3

3. Scanning With Impressario

This chapter explains how to use gscan to scan images. It assumes that you have a
scanner connected to your system, and that you have set up the scanner software as
described in “Setting Up an Impressario Scanner.”

The chapter covers these topics:

• “Overview of the Scanning Tool” on page 24

• “About the Menus” on page 25

• “The Scanning Process” on page 28

• “Choosing the Image Source” on page 29

• “Choosing the Scanning Destination” on page 31

• “Using Color Management” on page 31

• “Prescanning the Entire Image” on page 33

• “Cropping the Prescanned Image” on page 34

• “Prescanning the Cropped Image” on page 35

• “Setting the Scanning Resolution” on page 35

• “Choosing Color, Grey Scale, or Black and White” on page 37

• “Scanning the Final Image” on page 37

• “Stopping a Scan Before It Is Complete” on page 40

• “Saving Scanning Settings” on page 40
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Overview of the Scanning Tool

The Impressario tool gscan lets you scan images from a variety of sources. Its main
window lets you select an image, preview it, crop it if necessary, and scan it to a selected
destination. You can even scan images to and from any IRIS® screen on your network,
allowing you to share information quickly without leaving your workstation.

Learn about:

• “Opening gscan” on page 24.

• “Sources You Can Scan From” on page 24.

• “Sources You Can Scan To” on page 25.

Opening gscan

To open gscan, see “Opening Impressario Tools” on page 2.

You can also start gscan in these ways:

• In the Scanner Manager, select the scanner you want to use, then choose “Open”
from the Scanner menu.

• On the desktop, double-click the gscan icon.

If the gscan icon is not on your desktop, choose “An Icon” from the Find toolchest,
type gscan in the Find an Icon window, then drag the icon that appears out onto
your desktop.

• On the desktop, drag your SGI Image file onto the gscan icon. This starts gscan
with the file selected as the image source.

Sources You Can Scan From

gscan lets you scan an image from:

• an installed scanner

• an IRIS screen, either your own or another one on the network

• an SGI Image file
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Sources You Can Scan To

gscan lets you scan the image directly to:

• an SGI Image file or a TIFF file

• an IRIS screen, either your own or another one on the network

• a printer

About the Menus

Read about:

• “The Setup Menu” on page 25.

• “The Parameters Menu” on page 26.

• “The Scan Menu” on page 27.

• “The View Menu” on page 27.

• “The Other Tools Menu” on page 27.

• “The Help Menu” on page 28.

The Setup Menu

The Setup menu lets you specify the image source, set up and advance a document feeder,
and save or remove current scanning settings. It contains these choices:

• “Scanner Source” lets you specify a scanner from which to scan.

• “Screen Source” lets you choose a host whose screen is displaying the image that
you wish to scan.

• “File Source” lets you choose a file from which to scan.

• “Feeder Options” is available if you have chosen a scanner as the image source and
that scanner has a document feeder. This choice displays a window that lets you
enable the feeder and set its options.

• “Advance Feeder” sends the next document into the feeder.
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• “Save Current Settings” saves all option settings that you changed during your
session with gscan.

• “Remove Saved Settings” discards all settings you previously saved, and returns all
options to their default settings.

• “Quit” stops gscan, and closes its window.

The Parameters Menu

The Parameters menu lets you specify the size, resolution, and color of the image. It
contains these choices:

• “Scan Area” displays a dialog box in which you can enter new values for the area
into which gscan scans the image; this crops the image. See also “Cropping the
Prescanned Image” on page 34.

• “Resolution” displays a dialog box in which you can specify the scanning resolution
settings. See also “Setting the Scanning Resolution” on page 35.

• “Color” scans the image in color. See also “Choosing Color, Grey Scale, or Black and
White” on page 37.

• “Grey” scans the image in grey scales.

• “Black and White” scans the image in black and white.

• “48 Bit Color” and “16 Bit Grey” let you take advantage of devices that supply more
than 8 bits per pixel per channel of data.

• “Disable Color Management” turns off color management.

• “Scanner Specific Options” starts a program that lets you change settings that are
specific to the scanner selected as your image source.

Tip: If you are not using color management, turn Disable Color Management off to stop
the prompt window from appearing. Also see “Using Color Management” on page 31.
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The Scan Menu

The Scan menu lets you scan and prescan the image. It contains these choices:

• “Prescan All” scans the image at a very low resolution and displays it in gscan’s
window. You use the prescanned image to preview and crop the image before
scanning the final image. See also “Prescanning the Entire Image” on page 33.

• “Prescan Selected Area” prescans only the portion of the image that appears within
the red outline. See also “Prescanning the Cropped Image” on page 35.

• “Previous Prescan” erases the prescanned image that is currently displayed, and
replaces it with the prescanned image that was previously displayed.

• “Scan Image” starts the final scan. See also “Scanning the Final Image” on page 37.

• “Stop Scan” stops the scan that is in progress. See also “Stopping a Scan Before It Is
Complete” on page 40.

The View Menu

The View menu lets you zoom your view in and out for more accurate cropping, and lets
you view the scanned image in a separate window.

• “Zoom In” magnifies your view of the image.

• “Zoom Out” reduces your view of the image.

• “View Scanned Image” displays your scanned image in a separate window.

The Other Tools Menu

The Other Tools menu lets you start associated tools. It contains these choices:

• “Scanner Manager” starts the Scanner Manager, which lets you add and delete
scanners, and set gscan’s default scanner.

• “Printer Status Panel” shows the queue window for the system’s default printer, or, if
you’ve selected another printer to which to scan, it displays that printer’s queue
window.
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The Help Menu

The Help menu contains a list of help topics. To view a topic, choose it from this menu.

The Scanning Process

To scan an image, follow these steps:

1. If gscan is not already running, start it by double-clicking the gscan icon in your
Icon Catalog, or see “Opening gscan” on page 24.

2. Specify whether you’re scanning an image from a scanner, an SGI Image file, or an
IRIS screen; see “Choosing the Image Source” on page 29.

3. Specify whether you want the image to go to a file, an IRIS screen, or a printer; see
“Choosing the Scanning Destination” on page 31.  The color management process
begins here, if you have color management turned on. See “Using Color
Management” on page 31.

4. Prescan the image to the gscan window to preview it; see “Prescanning the Entire
Image” on page 33.

5. If you like, crop the image so gscan will scan only a portion of the image; see
“Cropping the Prescanned Image” on page 34.  Then you can prescan only the
cropped area; see “Prescanning the Cropped Image” on page 35.

6. Select a scanning resolution; see “Setting the Scanning Resolution” on page 35.

7. Select a color, grey scale, or black and white scan; see “Choosing Color, Grey Scale,
or Black and White” on page 37.

8. Scan the image; see “Scanning the Final Image” on page 37.  If you decide to stop
the scan before it is complete, see “Stopping a Scan Before It Is Complete” on
page 40.

9. If you like, you can save the scanning settings; see “Saving Scanning Settings” on
page 40.

You do not need to perform each step every time you use gscan, and you do not need
to perform all the steps in sequence. gscan uses a selected option as a default value until
another selection is made.
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For example, once a scanning destination and resolution are selected, gscan uses the same
destination and resolution until you change them. This allows you to scan an additional
image in just two or three steps.

Choosing the Image Source

gscan can scan an image from three different types of sources:

• To scan an image from a scanner, choose “Scanner Source...” from the Setup menu,
then see “Choosing to Scan From a Scanner” on page 29.

• To scan an image from an IRIS screen, choose “Screen Source...” from the Setup
menu, then see “Choosing to Scan From an IRIS Screen” on page 30.

• To scan an image that’s in an SGI Image file, choose “File Source...” from the Setup
menu, then see “Choosing to Scan From an SGI Image File” on page 31.

Choosing to Scan From a Scanner

To specify that the image you want to scan is located in a scanner bed, follow these steps:

1. Choose “Scanner Source...” from the Setup menu.

2. In the Select Scanner window that appears, select the scanner you want to use.

If no scanners appear in the window, make sure the scanner software is set up
correctly; see “Setting Up Scanner Software” on page 7.

3. Click the OK button.

If you chose a scanner that’s connected to another system on your network and it is
currently in use, you will see a notifier that reports which user is using the scanner.
The scanner cannot queue jobs, so you must wait until the scanner is available.

4. If your scanner has a document feeder that you want to use, choose “Feeder
Options...” from the Setup menu; then click the box next to Use Feeder, and click
OK.

See “Using an Automatic Document Feeder” on page 38 for information on the
options included in the Feeder Options window.

5. If color management is enabled (it can be enabled or disabled from the Parameters
pull-down menu) a list of device profiles appear. Device profiles are used to “tag”
the image that is to be scanned with information that describes the color
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characteristics of the scanner. This information is then used to provide color
management when the image is printed with Impressario. Select a profile that best
describes your scanner. See “Using Color Management” on page 31 for more
information.

Note: When using a transparency adapter on an HP ScanJet scanner, the material to
be scanned must be placed 1.75 in. (45 mm) below the top of the scan window
because this top area is used for calibration. If the material to be scanned is placed
within the calibration area, the scan will not be successful and the scanner may reset
the SCSI bus.

Note: Color profiles are not available for all scanners.

Choosing to Scan From an IRIS Screen

To specify that you want to scan an image that is displayed on an IRIS screen, follow
these steps:

1. Choose “Screen Source...” from the Setup menu.

2. In the Select Screen window, type the name of a system in the text field; or click List
Hosts to see a list of systems on the network, and select the one from which you
want to scan the image.

3. Click OK.

4. If color management is enabled (it can be enabled or disabled from the Parameters
pull-down menu) you will see an option to Change Profile. Selecting the option will
display a list of device profiles for various monitors. Device profiles are used to ’tag’
the image that is to be scanned with information that describes the color
characteristics of the monitor. This information is then used to provide color
management when the image is printed with Impressario. Select a profile that best
describes your monitor. See “Using Color Management” on page 31 for more
information.

Note: Color profiles are not available for all monitors.
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Choosing to Scan From an SGI Image File

To specify that you want to scan an image that is in an SGI Image file, follow these steps:

1. Choose “File Source...” from the Setup menu.

2. In the Select File window click on an existing file.

3. Click the OK button.

Choosing the Scanning Destination

Impressario can scan an image to three different types of destinations:

• To place the scanned image in an SGI Image or TIFF file, click the box next to Scan
To File; see also “Scanning to a File” on page 37.

• To display the scanned image on an IRIS screen, click the box next to Scan To Screen;
see also “Scanning to a Screen” on page 39.

• To send the scanned image directly to a printer, click the box next to Scan To Printer;
see also “Scanning to a Printer” on page 39.

Using Color Management

Understanding Impressario’s Color Management

All scanners, printers and monitors have different color characteristics that affect the
color they measure or display. If you were to scan the same image on two different
scanners and print them both on the same printer, they would look different (because the
two scanners will measure the light from the scanned image differently). Similarly, if you
were to scan an image and print it on two different printers, the images would look
different (because of different inks and printing technologies employed by different
printers).

Impressario uses International Color Consortium (ICC) profiles to perform color
management. ICC profiles contain information about the color characteristics of source
and destination devices used to acquire and display images. A scanner is an example of
a source device; a printer is a destination device. Separate profiles are available for
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various scanners, printers, and monitors. By combining the information from the source
and destination profile, a color correction can be determined and applied to the image.
The result is a printed, or displayed image (using a monitor) that looks more like the
original.

Choosing a Source Profile

When you choose to scan from a scanner, or from an IRIS screen, gscan prompts you to
select an ICC profile from a list. This profile is the SOURCE profile —it describes the color
characteristics of your scanner or monitor (if you are scanning from the screen). gscan
‘tags’ your image with the source profile data for later use by using color management
software.

Note: You should choose the ICC profile from the list that describes your scanner or
monitor. ICC profiles are not available for all scanners and monitors; if you do not see an
appropriate profile select “No profile” from the list.

Later, when you print the image, the Impressario printer driver will color correct the
image using the source profile (that was recorded when the image was scanned) and a
destination profile specific to the printer being used. Impressario automatically
determines the destination profile to use.

Choosing a Destination Profile

In addition to choosing a source profile, you can also use gscan to apply the destination
ICC profile if you know what the output device will be.

Note: Only specify a destination profile if you are scanning an image and you know it
will be printed on a specific printer (or displayed on a specific monitor) that does not
have color management available; otherwise, it is best not to specify the destination ICC
profile from within gscan.

The Select File window allows you to specify a destination ICC profile (the Select File
window is presented when you scan to a file). Normally, the ICC profile listed will be the
source profile you selected when you specified the scanner source. You may change the
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destination ICC profile by selecting the Change profile button on the Select File menu.
This will bring up a browser that lets you browse through all of the ICC profiles on your
system. Select the ICC profile that matches the output device that you intend to use.

Prescanning the Entire Image

Once the image source and the scanning destination are selected, you can prescan the image
to the gscan window for viewing and cropping. Prescanning scans the image at a very
low resolution so you can quickly preview and crop the image before scanning it at a high
resolution.

To prescan the image, either click the Prescan All button in the gscanwindow or choose
“Prescan All” from the Scan menu.

The image appears in the image viewing area ofgscan as shown in Figure 3-1. The entire
source image is displayed; you can now view and crop the image, then prescan it again
(see “Cropping the Prescanned Image” on page 34 and “Prescanning the Cropped
Image” on page 35). When you have cropped the image as you want it to appear in the
final scan, see “Scanning the Final Image” on page 37.

Figure 3-1 The gscan Window With a Prescanned Image
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Cropping the Prescanned Image

To crop the prescanned image, hold down the left mouse button and drag a box around
the desired area. A box with handles on each line and at each corner appears around the
area you’ve selected. The coordinates and dimensions of the selection box are displayed
in the upper right of the gscan window. See Figure 3-2.

Figure 3-2 The gscan Window With an Area of the Prescanned Image Cropped

If you want to modify the selected area, drag on the box handles to change the
dimensions of the box or drag on a side of the box to reposition it. You can also enter the
coordinates of the boxed area manually:

1. Choose “Scan Area...” from the Parameters menu.

The Scan Area window appears.

2. Enter the X and Y coordinates for the upper left corner of the selection box.

3. Enter the width and height of the box.

4. Click to select Pixels, Inches, or Centimeters as the unit of measurement.

The button next to the chosen item turns blue to indicate its selection.

5. Click OK.
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Zooming the Image

You can zoom in on the prescanned image by choosing “Zoom In” from the View menu.
Magnifying the image in this way helps you get a more precise image area selection for
the final scan.

Note: Zooming in does not increase the resolution (pixel density) of the image; it only
magnifies its appearance on screen. A zoomed image in the prescan viewing area will be
visibly degraded. To return the prescanned area to its original screen resolution, zoom
out again after selecting an area of the image for the final scan.

To pan around the entire magnified image, use the scroll bars along the bottom and right
side of the image viewing area.

To zoom out after examining the prescanned image, choose “Zoom Out” from the View
menu.

Prescanning the Cropped Image

To prescan only the portion of the image that is within the red outline, choose “Prescan
Selected Area” from the Scan menu.

If you are not happy with the results of a prescan, you can return to the previous prescan
by choosing “Previous Prescan” from the Scan menu. This command lets you toggle back
and forth between the current and the previous prescan.

Setting the Scanning Resolution

The gscan window provides control bars to set the resolution of the image scan.

There are separate control bars for the X and Y resolutions. The two resolutions are the
same, so the control bars are locked together by default. With the control bars locked
together, changing either one changes them both.

Click on the arrow at the right end of the control bar to increase the resolution, click on
the left arrow to decrease resolution. By default, the resolution changes incrementally to
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reflect the optimal resolutions for the source medium. To change this default behavior,
see “Adjusting Advanced Resolution Settings” on page 36.

Adjusting Advanced Resolution Settings

Choose the “Resolution...” command in the Parameters menu to display the Resolution
window and additional resolution options.

“Keep X and Y Resolutions Equal” is selected by default. This setting locks the X and Y
control bars together. Click the button to toggle the setting off if you want the two
dimensions to have different resolutions. The image will appear stretched in the
dimension with the higher resolution.

Some scanners have inaccuracies in their resolution specifications, which can cause the
scan area in the final scan to contain slightly more or less information than the area
outlined in red in the viewing area. Normally, when “Prescan at Selected Resolution” is
off, gscan prescans at a resolution that results in an image that fits into the viewing area.
If “Prescan at Selected Resolution” is on, gscan uses the resolution displayed on its main
window for prescans (as well as final scans), scaling the image so that it fits in the
viewing area. This eliminates scan area inaccuracies at the cost of slower prescans.

“Hardware Resolutions Only” is selected by default. This setting lets the equipment
providing the source image determine the available resolutions. Click the button to
toggle the setting off if you want to scan at a resolution not natively supported by the
equipment. You can then enter the desired scanning resolution into the text field that
appears above the resolution control bars.

Scanning with “Hardware Resolutions Only” turned off can result in unusual and
unpredictable image scans so gscan provides several “Rescaling Filters” to adjust the
image. The filters are based on complex mathematical models that are beyond the scope
of this guide. They are listed in order from standard quality (Scanner Driver) to very high
quality (Gaussian); the higher the quality, the longer the scan will take as it will consume
much more CPU power. Try experimenting with the filters to determine which renders
appropriately for your needs.

You can also choose between the resolution units “pixels/inch” and “pixels/cm” in the
Resolution window. “Pixels/inch” is the default.
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Choosing Color, Grey Scale, or Black and White

gscan scans in color, grey scale, and black and white. gscan can scan more than 274
trillion colors and 65,536 shades of grey; however, the color and grey scale palette may
be limited by the source image, the equipment providing the source image, and the
equipment to which the image is being sent. A common hardware limit is 16.7 million
colors and 256 shades of grey.

Choose “Color,” “Grey,” or “Black and White” from the Parameters menu.

Scanning the Final Image

When you have set all the necessary parameters and are ready to scan the image, click
the Scan Image button in the gscan window or choose “Scan Image” from the Scan
Menu. A window appears that lets you select the scanning destination for the image; when
you have done so, gscan begins the scan.

To stop the scan while it is under way, click the Stop Scan button in the gscan window.

Scanning to a File

To scan an image into an SGI Image file or a TIFF file, follow these steps:

1. Click the box next to File in the Scan To: area of the window.

2. If your scanner has an automatic document feeder that you want to use, choose
“Feeder Options...” from the Setup menu, and click the Help button in the Feeder
Options window for information on setting the options.

3. Choose “Scan Image” from the Scan menu.

4. In the File Type window, choose whether to place the image in an SGI Image file or a
TIFF file.

5. Enter a name for the file or click to select an existing file from the list if you want to
overwrite a file.

6. If color management is enabled (it can be enabled or disabled from the Parameters
pull-down menu) you will see an option to Change Profile. The Change Profile
option from this menu allows you to specify a destination device (printer or
monitor) that the scanned image will be displayed on. Printers supported by
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Impressario have color management support; you do not need to change the
destination profile if you will be printing with Impressario. See “Choosing a
Destination Profile” on page 32 and “Using Color Management” on page 31 for
more information.

7. Click OK.

8. To stop the scan before it is complete, click the Stop Scan button.

When the scan is complete, your image is in a file. To view the scanned image, choose
“View Scanned Image” from the View menu. The image appears in a vstiff window
(see Chapter 4, “Viewing Files With vstiff”).

Using an Automatic Document Feeder

If the Feeder Options window is not already open in gscan, open it by choosing “Feeder
Options” from the Setup menu.

To enable the document feeder, click the box next to Use Feeder.

With TIFF files, you can either create one file per scanned image, or you can put several
distinct scanned images into one file (one scanned image appears on each “page” of the
file). Click Each Image in a Separate File or All Images in One File.

Note: You can save only one image to an SGI Image file.

When scanning multiple images to separate SGI Image files or TIFF files, gscan uses the
file name you specified for the image and appends a sequential series of numbers to
name each file you create. For example, if the image filename is myscans and you enter
0 (zero) as a starting number, gscan automatically creates the files myscans0,
myscans1, myscans2, and so on.

Enter the starting number for the sequence in the Starting Number field of the Feeder
Options window.
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Scanning to a Screen

To scan an image directly to your IRIS screen, follow these steps:

1. Click the box next to Screen in the Scan To: area of the window.

2. Choose “Scan Image” from the Scan menu.

3. In the Select Screen window, type the name of a system in the text field; or click List
Hosts to see a list of systems on the network, and select the one to which you want
to scan the image.

4. If color management is enabled (it can be enabled or disabled from the Parameters
pull-down menu) you will see an option to Change Profile. You can use this to select
a profile that describes the screen (monitor) characteristics of the screen that you are
scanning to (this improves the color matching to the original being scanned). See
“Using Color Management” on page 31 for more information.

Note: Color profiles are not available for all monitors.

5. Click OK.

6. To stop the scan before it is complete, click the Stop Scan button.

The image is scanned and then displayed on the selected screen in a vstiff window.
See Chapter 4, “Viewing Files With vstiff” for information on the vstiff window.

Scanning to a Printer

To scan an image directly to a printer, follow these steps:

1. Click the box next to Printer in the Scan To: area of the window.

2. Choose “Scan Image” from the Scan menu.

3. In the Select Printer window, select the printer and its options.

■ Click to select a printer from the Available printers list.

■ Set options in the Options area.

4. To start the scan, click OK in the Select Printer window.

5. To stop the scan before it is complete, click the Stop Scan button in the gscan
window.
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The image is scanned and then printed on the selected printer. To check the printer’s
queue, choose “Printer Status Panel” from the Other Tools menu.

Stopping a Scan Before It Is Complete

To stop a scan that is in progress, click the Stop Scan button.

If you were scanning to a file, gscan automatically removes the file.

Saving Scanning Settings

To save all of gscan’s current settings, choose “Save Current Settings...” from the Setup
menu; then click OK when the message box asks for confirmation.

To return to the default settings after saving your custom settings, choose “Remove
Saved Settings...” from the Setup menu; then click OK when the message box asks for
confirmation.
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Chapter 4

4. Viewing Files With vstiff

Overview of vstiff

The Impressario tool vstiff lets you view Stream TIFF (STIFF) files. Stream TIFF is a
subset of TIFF (Tagged Information File Format) and is based on version 6.0 of the TIFF
specification.

vstiff can also be used to view other types of files:

• If the PostScript interpreter psrip is installed on your system, vstiff
automatically invokes psrip to convert a PostScript file to Stream TIFF, and then
displays the file.

Note: psrip is included with the Impressario software; however, an optional
license must be purchased if you wish to use psrip.

• If fileconvert is installed on your system, vstiff automatically invokes
fileconvert to convert a file to PostScript, invokes psrip to convert the
PostScript file to Stream TIFF, and then displays the file.

vstiff also uses fileconvert to convert GIF (Graphics Interchange Format),
TIFF, SGI Image, PPM, and JPEG files directly to STIFF.

The Help menu provides a variety of help topics. If you need additional help information
while using vstiff, use the Help menu that appears in the tool’s main window, or click
the Help button that appears in any subsequent windows.
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Opening a File

To display a file using vstiff:

1. If vstiff is not already running, start it by double-clicking the launch icon. See also
“Opening Impressario Tools.”

2. Select “Open...” from the File menu.

The Select File window appears. Select File is a standard file browsing window.

3. Click to select the desired file from the list or enter a filename in the text field; then
click OK.

4. Use the commands in the Page menu to browse through the contents of the file.

Setting PostScript Options

vstiff offers several options for displaying a PostScript file (including any file
converted to PostScript). To set these options, choose “PostScript Options...” from the file
menu. The PostScript options window appears.

• “Bits Per Color” lets you display the PostScript file in one bit, four bits, or eight bits
per pixel per color.

• “Color Space” lets you specify either black and white or color display for the
PostScript file.

• “Resolution” lets you enter the desired screen resolution for the displayed file.

• “Force Landscape Mode” lets you display the PostScript file in landscape mode.

Click Reopen to view the file that is currently open with the new settings. Click OK to
save the options you have set.

If you click OK and do not click Reopen in this window, the options apply to the next file
you open; a file that is currently open is not affected. To make the options apply to the
file that is currently open, choose “Reopen” from vstiff’s File menu.
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Chapter 5

5. Impressario Administration

This chapter provides information for the person who is the administrator of the system,
or who sets up printers and scanners and troubleshoots problems.

Setting Default Printer Options for the System

The administrator of the system can set default printer-specific options using the Printer
Manager. Once these options are set, they automatically apply to all print jobs submitted
by all users. Any user can override the default options using either the Printer Manager
(as described below) or PrintPanel (see “Setting Options for Printing Files” on page 15);
the new options will apply only to print jobs submitted by that user.

Note: If a user prints from the command line using the lp command and specifies an
option using -o then all default printer-specific options are ignored (the options specified
with -o are the only options used in this case).

The administrator can set default printer-specific options by following these steps:

1. Log into the system as root.

2. Start the Printer Manager by clicking the launch icon, or by choosing “Printer
Manager” from the System toolchest.

3. Choose “Set Options” from the Printer menu.

4. Set the printer-specific options (see “Setting Options for Printing Files” on page 15
for information), then click the OK button.

5. In the dialog box that appears, click the All Users button.
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Client/Server Printing

Impressario has a client/server network printing architecture. Impressario servers are
workstations that control at least one printer or scanner. Impressario clients are
workstations that use the printers or scanners controlled by Impressario servers.

When you submit a print job from an Impressario client, your file, along with any print
options, is transmitted to the server. The server queues up your print job upon receipt of
a print request. Once the printer you specified is available, the server processes the
options sent with the print job, converts the file to a printable format (if necessary), and
then prints the file. The client polls the server occasionally to retrieve information on the
status of the printer and the print queue. The server processes these requests and sends
back the information to the client.

The server consists of drivers that communicate with the printer, and filters that convert
data from one format to another.

The client consists of graphical tools for submitting and monitoring the status of a print
job, and a network interface for sending print requests to the server.

Impressario uses the SVR3 spooling system to queue print jobs. Impressario
supplements the spooling system with graphical printing tools, filters, and a network
status daemon called podd. The configuration files for the spooling system are located in
the directory /var/spool/lp. The following additional directories are created when
Impressario is installed:

/var/spool/lp/pod
contains the configuration, status, and log files for each directly
connected printer

/var/spool/lp/gui_model
contains the templates for the graphical options panels for each printer

/var/spool/lp/gui_interface
contains the instantiations for the graphical options panels for each
printer

/var/spool/lp/settings
contains the printer settings files (see below)

/var/spool/lp/activeicons
contains “tagged” files that represent the state (busy, idle, broken) of a
printer; they are used for iconic representation of printers on the desktop
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/var/spool/lp/app-defaults
contains application default files for PrintPanel for remote printers

/var/spool/lp/devices
contains device files for printers

/var/spool/lp/psparams
contains PostScript interpreter files

/var/spool/lp/psparams
scratch files and working directory for the PostScript interpreter

/var/spool/lp/PPD_model
contains PostScript Printer Definition (PPD) files for the Impressario
PPD driver

/var/spool/lp/PPD_untested
contains untested PostScript Printer Definition (PPD) files for the
Impressario PPD driver

Printer Settings

This section identifies the location of the settings files and describes ways to save
multiple settings for a single printer.

Note: See Chapter 2, “Printing With Impressario,” for information on saving the settings
for a particular printer.

The Settings File

When you save printer settings, the configuration information is saved in the directory
/var/spool/lp/settings. Within this directory are directories named after each
printer on your system. For example, the settings files for the printer named “speedy”
are located in the directory /var/spool/lp/settings/speedy. The settings files are
named after the user who saved printer configuration information from the PrintPanel.
Thus, if the users named “joe” and “peg” saved settings for the printer “speedy,” there
will be settings files named /var/spool/settings/speedy/joe and
/var/spool/settings/speedy/peg.
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Creating Multiple Configurations for a Single Printer

You may find it convenient to save useful groups of settings for a single printer. For
example, say you have a printer named “speedy” that can print single-sided or
double-sided pages. Whenever you print presentations, you want them single-sided;
when you print long documents, you want them double-sided.

Rather than change speedy’s settings when you change the type of document you’re
printing, you can create two instances of speedy, say “speedysingle” and
“speedydouble.” Set one to print single-sided and the other to print double-sided. You
can print to these new printer queues directly from an application, by dragging and
dropping the file (see “Dragging and Dropping Files to Print” on page 15), or by opening
PrintPanel and selecting the file you want to print (see “Opening Impressario Tools” on
page 2).

To create a copy of speedy with new printer options, use the Printer Manager to add a
new printer queue (adapt this example as needed):

1. Open the Printer Manager from your System toolchest.

2. Type in the new printer name. For example, speedydouble.

3. Choose Remote Host.

Note: Even if the printer is connected directly to your workstation, choose Remote
Host instead of Local Host.

4. Type in the name of the SGI system that administers “speedy.”

5. Click on List Printers. A list of printers appears, including speedy.

6. Choose speedy from the Printer List, and click OK to exit this window. A printer
icon called speedydouble now appears in the Printer Manager.

7. Click once on the speedydouble icon to select it.

8. Click Options. Change the paper to double-sided, and click OK to exit this window
and save the new settings.
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Client/Server Scanning

You can use the Scanner Manager to access a scanner that is connected to another system
on the network (see “Setting Up Scanner Software” on page 7) and use gscan to scan
from the scanner (see “Choosing to Scan From a Scanner” on page 29) as long as both
systems have Impressario installed.

When you set up a new scanner or access it for scanning, the client system contacts the
server system and requests that it start the scannerd daemon. Since scanners cannot
queue scan jobs, only one user can use the scanner at a time.

Viewing a Document Online

The Impressario Server printing software can recognize many different types of files.
Once a file type is identified, the printing software uses a set of rules to convert the file
from its original type into a printable format.

Included with Impressario is the file viewing program vstiff. vstiff uses the same
set of rules as the printing software and is able to convert virtually any type of file into a
format that can be viewed on your display. You can use vstiff as a debugging tool; if a
print job does not print or prints incorrectly, run vstiff on the file you want to print
and note any error messages it displays.

Note: vstiff uses the PostScript interpreter psrip to display some file types. psrip is
included with the Impressario software; however, an optional license must be purchased
if you wish to use psrip. If the optional license has not been purchased then you can use
the showps command to display PostScript files.

See Chapter 4, “Viewing Files With vstiff” and the vstiff(1) reference page for
information on using vstiff.

Note: The rule set and filters exist only on an Impressario server. vstiff cannot convert
all printable files into a viewable format on systems that do not have Impressario
installed.
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Troubleshooting Printing Problems

Once you’ve used the Printer Manager to set up the printers that you want to access (see
“Setting Up an Impressario Printer” on page 4), printing files is usually very
straightforward—you ask an application to print a file, then pick up your completed job
from the printer.

The work that the system does to make files print, however, is fairly involved—especially
when you are sending files over a network to printers that are not directly connected to
your workstation. If printing problems do arise, the information in this section should
help you correct them quickly.

The information applies to you only if you are printing from within an application or
from the desktop.

This section covers two main topics:

• “A Troubleshooting Roadmap” on page 48 gives you a brief overview of the
printing process, plus step-by-step information to isolate and resolve printing
problems. You’ll get more out of this section if you also read “Understanding the
Printing Process”, but, if you’re anxious to resolve a problem without reading
through background information, start with this section.

• “Understanding the Printing Process” on page 58 describes the process in detail,
outlines how and when the process may fail, and describes the troubleshooting
tools that are available to you.

A Troubleshooting Roadmap

A successful printing process includes these four basic steps:

• You must issue a print command and specify a printer that is set up to work with
your system.

• Your system (the local system) must correctly process the request and send it to the
system to which the printer is physically attached (the printing system).

Note: If the printer is physically attached to your system, the local system is also the
printing system; if the printer is attached to another system on the network, that
system is the remote printing system.
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• The printing system must process the print request and send it to the printer.

• The printer must be in working order; if it’s out of paper or toner, it cannot print.

See “Understanding the Printing Process” on page 58 for a more detailed description of
what the system does at each step.

The troubleshooting steps below show you how to determine which part of this process
is failing. Be sure you know the administrator’s password; various steps require that you
become the administrator.

1. If you sent your job to the printer more than 30 minutes ago, send it again. This way
you can monitor its progress from the start.

2. Start the Printer Manager by choosing “Printer Manager” from the System toolchest.

3. Find the icon for the printer to which you sent your job.

• If the icon is there, double-click it to open it.

• If you don’t see the icon, that printer has not been set up to work with your
system. See “Setting Up an Impressario Printer” on page 4.

4. Find your print job in the queue.

The entries in this window are jobs that have already reached the printer’s queue.

• If you see your job in the queue and the printer is attached to the local system,
skip ahead to step 6.

• If you see your job in the queue and the printer is attached to a remote system, go
on to step 5.

• If you don’t see your job, see “Job Never Appears in the Local Queue” on
page 51.

Note: Your job may not appear in the queue immediately after you issue the
print command; either it printed so quickly that the system didn’t have time to
display it in the queue, or there is a problem. If the printer did not print the job,
wait several minutes before assuming it’s not going to appear in the queue.

5. Physically go to the system to which the printer is connected. Its queue contains all
print jobs that have actually reached the system. Find your print job in the remote
queue.
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Your job is labeled with your login name and is the same size as it is in the local
queue. It does not have the same job number.

• If you see your job in the remote queue, go on to step 6.

• If you don’t see your job, see “Job Never Appears in the Remote Queue” on
page 53.

6. Watch the queue of the printing system (the system to which the printer is attached).

• If your job disappears from the queue, skip ahead to step 9.

• If after several minutes no jobs disappear from the queue, go on to step 7.

• If all the jobs ahead of yours disappear, and jobs behind yours disappear while
yours remains at the top of the queue, delete your job and try to print it again.

7. Make sure the printer is printing requests. Physically go to the system to which the
printer is attached, open the printer’s queue window, and choose “Printer Printing
Your Queued Jobs” from the Queue menu.

• If your job disappears from the queue, skip ahead to step 9.

• If no jobs disappear from the queue, go on to step 8.

8. Check whether lpsched, the print spooler that controls the flow of jobs out of the
queue, is running. On the printing system, open a shell window and type:

lpstat -r

Then press Enter.

• If the lpsched spooler is running, you see this message:

scheduler is running

Go on to step 9.

• If the lpsched spooler is not running, you see this message:

scheduler is not running

See “Checking and Restarting lpsched” on page 57 to turn it on.

9. Check the physical state of the printer; for example:

• Turn the printer off and on.

• Make sure the paper or transparencies are properly loaded, there is enough
toner, and the printer isn’t physically jammed.

• Check all status lights and panels on the printer for error messages.
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• Make sure the cable is securely connected to the correct ports on both the
system and the printer.

• If you find a physical problem, correct it and try printing again.

• If you find no physical problem and no jobs disappear from the queue, the job’s
owner (possibly you) should cancel the job and try to print it again. If the next
job in the queue does not disappear, go on to step 10.

• If you find no physical problem and your job disappears from the queue but
does not print, see “Job Disappears From a Queue but Never Prints” on
page 55.

10. Remove all jobs from the queue and choose “Send Test Page” from the Printer menu
to send a test page.

• If the test page prints, try printing your job again.

• If the test page doesn’t print, contact your local support organization.

Job Never Appears in the Local Queue

Use this section if the printer icon to which you sent your print job appears in the Printer
Manager, but your job does not appear in the local queue. You should be looking at the
printer’s queue window.

1. Choose “Send Test Page” from the Printer menu to test the printer setup.

• If the test job appears in the queue, try printing your job again. If your job still
doesn’t appear, go on to step 2.

• If the test job does not appear in the queue, make sure both “Printer Accepting
Your Jobs” and “Printer Printing Your Queued Jobs” are chosen in the Queue
menu. Send another test job. If it still doesn’t appear, contact your local support
organization.

2. Make sure you followed the correct steps to specify a particular printer for your job.

• If you chose from a list of available printers and the job doesn’t appear in the
queue, go on to step 3.

• If you typed the printer name into a field, or if the application filled in the field
for you, make sure the name exactly matches that of a printer that appears in
the Printer Manager; then try printing again. Remember that names are
case-sensitive; “Printer1” is not the same as “printer1”. If the printer still
doesn’t appear, go on to step 3.
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• If you didn’t explicitly specify a printer when you made the print request, either
you or the application previously specified a default printer; the job may be in
another printer’s queue.

See the user’s guide that came with the application to find out how it specifies a
default printer and how you can change it. (For example, when you select a file
and choose “Print” from the Selected toolchest or menu, the file is automatically
sent to the printer that you specified as the default in the Printer Manager.)
Change the default and try printing again. If it still doesn’t appear, go on to
step 3.

3. Make sure you gave the application all the printing information it needs.

Some applications have both a print command and a print dialog box. If a dialog
box appeared and you didn’t notice it, didn’t fill it out correctly, or didn’t confirm
your information (that is, click an Accept or OK button), the job will not go to the
queue.

• If there is a dialog box, fill it out completely, then try printing again. If the job
still doesn’t appear in the queue, go on to step 4.

• If there is no dialog box, go on to step 4.

4. Open the console window and check for error messages.

Note: You must look in the console; error messages will not be reported to any other
shell window.

• If there are no error messages, contact your local support organization.

• If a message states that you’re out of disk space, then there isn’t enough space
for the system to create a version of the file that is in the correct format for the
printer. Remove files or directories that you no longer need and try to print
your job again. You could also try just printing a range of pages rather than the
entire file.

• If a message specific to the application from which you are printing appears, for
example, a message stating that the application couldn’t find a necessary file,
refer to the documentation that came with the application.

5. Look in the file /var/spool/lp/log for error messages.
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Job Never Appears in the Remote Queue

Use this section if your print job appears in your local queue, but does not appear in the
queue when you view it on the system that’s connected to the printer. You should be
looking at the printer’s queue window.

1. See if there is already a different job in the remote queue that was sent from your
local queue (that is, a job that belongs to you or to another user on your local system).

• If no jobs from your local queue appear in the remote queue, go on to step 2.

• If your local queue has already sent one job to the remote queue, it will not send
another job to the remote queue until the first one prints. Wait until the first job
disappears and, if your next job still does not appear in the remote queue, go on
to step 2.

2. Make sure the local printer queue is sending print requests to the remote system.

• Make sure “Printer Printing Your Queued Jobs” is chosen in the Queue menu. If
no jobs from your local queue appear in the remote queue, go on to step 3.

3. Make sure the information about the remote system and remote printer that is shown
in the printer’s queue window is accurate.

• If someone changed the name of the printer or physically moved the printer and
connected it to another workstation, your jobs cannot reach it. See “Changing
the Setup of a Printer” in Chapter 3 of your Personal System Administration Guide
to give the system the new information. Then try printing again.

• If the information about the remote system and printer is accurate, go on to
step 4.

4. Check whether lpsched, the print spooler that controls the flow of jobs from the
local queue to the remote system, is running. On your own system, open a shell
window and type:

lpstat -r

Then press Enter.

• If the lpsched spooler is running you see this message:

scheduler is running

Go on to step 5.

• If the lpsched spooler is not running you see this message:

scheduler is not running
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See “Checking and Restarting lpsched” on page 57 to turn it on.

5. Test the network connection by opening a shell window and using the
/usr/etc/ping command with the remote system’s hostname. For example, if the
remote hostname is mars, type:

/usr/etc/ping mars

Then press Enter. You see some messages that will repeat indefinitely; to stop the
messages, press Ctrl-C. You see a summary of the connection. Look for these lines:

mars PING statistics

<#>packets transmitted,<#> packets received,0% packet loss

• If this line reports 0% packet loss, your connection to the remote system is
working. Go on to step 6.

• If this line reports between 1% and 100% packet loss, your connection to the
remote system is not stable. Physically go to the remote system to make sure both
the printer and the system are turned on. If they were off, turn them on, and try
to print again.

If they were already turned on, make sure the remote system is communicating
with the network; use the /usr/etc/ping command on the remote system to
try to reach a system on the network other than your system.

If the remote system can communicate with any other system on the network,
your system may not be connected to the network properly. On your own
system, try the /usr/etc/ping command with another hostname; also make
sure your network cable is properly connected to your workstation. If you
cannot communicate with any system over the network, or if a high percent
packet loss continues, contact your network administrator. Either your network
connection or the network itself has a problem.

6. Check the access permissions on the remote system by trying to copy a file to the
remote system using the same login account that lpsched uses to copy over your
job. For example, use jot to create a small text file named testit, then copy it to
the remote system (mars) using the lp account; type:

su lp

rcp testit lp@mars:/usr/tmp

• If you see no error messages, the file successfully reached the remote system. Go
on to step 7.
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• If you see an error message saying that the login was incorrect or that
permissions were denied, contact the Administrator of the remote system; the
Administrator needs to make changes to the lp account.

7. Choose “Send Test Page” from the Printer menu on your own system to test the
printer setup.

• If the test job appears in the remote queue, go on to step 8.

• If the test job does not appear in the remote queue, physically go to the remote
system, open the queue window for the printer, and turn off and on “Printer
Printing Your Queued Jobs” and “Printer Accepting Your Jobs” in the Queue
menu. Go back to your own system and send another test job. If the test job
appears, try to print your job again.

8. Physically go to the remote system and open the console window to check for error
messages.

Note: You must look in the console on the remote system; error messages will not be
reported to any other shell window.

• If a message states that the system is out of disk space, then there isn’t enough
space for the system to accept the file or to make a copy of the file to print. Have
the Administrator of the remote system remove files or directories that are no
longer needed and try to print your job again.

• If a message specific to the application from which you are printing appears, for
example, a message stating that the application couldn’t find a necessary file,
refer to the documentation included with the application.

• If there are no error messages, try to print your job again. If your job still does
not appear in the remote queue, contact your local support organization.

Job Disappears From a Queue but Never Prints

Use this section if your print job disappears from a local or remote queue but the printer
never prints it out.

1. Check your mail messages.

• If the administrator of the printing system deletes your job, you receive a mail
message to that effect. Contact the administrator to make sure you may try to
print the job again.
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• If there is no such mail message, go on to step 2.

2. Check whether the printer is printing any jobs.

• If the printer prints the next job in the queue, there is something wrong with
your particular job; go on to step 3.

• If all jobs are disappearing from the queue but the printer does not print them,
skip ahead to step 4.

3. Send the job again, and check whether the printer receives it.

Most printers have a status mechanism (a blinking light or digital message) that
shows that the printer has received a job and is trying to print it.

• If the status mechanism shows that it is trying to print your job but never does,
the job is too complex; the printer either gave up after a specified period of time
(that is, it “timed out”), or the printer does not have enough memory to hold the
job. If possible, break it up into smaller jobs and try printing it again (for
example, send only two pages of a ten-page document). If it still doesn’t print,
go on to step 4.

• If the status mechanism doesn’t show that it is trying to print a job, the printer
didn’t receive data that it could understand. This means the initial processing
that your application or other filter did to prepare the file for printing did not
produce a file in the correct format for this printer. You may be missing some
filtering software. Try printing the file on a different type of printer. For
example, if you initially sent your job to a color image printer connected to a
parallel port, now send it to a black and white PostScript printer connected to a
serial port. If it still doesn’t print, go on to step 4.

4. Remove all jobs from the queue on the printing system and choose “Send Test Page”
from the Printer menu to send a test page.

• If the test page prints, the printer is set up correctly, but cannot print the types of
files you are sending it. Contact your local support organization.

• If the test job disappears from the queue but doesn’t print, contact your local
support organization.
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Checking and Restarting lpsched

Use this section to check whether lpsched is running, and to restart it if necessary.

1. Check whether lpsched is running by typing:

lpstat -r

Then press Enter.

• If the lpsched spooler is not running, you see this message:

scheduler is not running

Go to step 2 to turn it on.

• If the lpsched spooler is running, you see this message:

scheduler is running

2. Turn on lpsched if it is not running.

■ Open a shell window on the system where it is not running, then log in as root
by typing:

su

Then press Enter.

If a prompt for a password appears, type the password, then press Enter. If a
prompt appears but the root account has no password, just press Enter.

■ Start lpsched by typing:

/etc/init.d/lp start

Then press Enter.

■ Log out of the root account by typing:

exit

Then press Enter.

3. Make sure lpsched is now running by typing:

lpstat -r

Then press Enter.

• If the lpsched spooler is running, you see this message:

scheduler is running
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Jobs that were not reaching a remote queue because lpsched was not running
on the local system should now reach that queue; jobs that were not
disappearing from the printing queue because lpsched was not running on
the printing system should now print out.

• If you do not see this message, contact your local support organization.

Understanding the Printing Process

This sequence of steps describes the process that your system uses to print files. The
details (such as system name, application name, and job IDs) are only examples.

1. On your own system (saturn), you ask an application (IRIS Showcase™) to print a
file (slide1), and explicitly or implicitly request a particular printer
(color-seiko).

2. IRIS Showcase (or another filter program) creates a new version of slide1 (a new
file) that is in the correct format for color-seiko.

3. IRIS Showcase runs the lp command on the file on saturn. lp assigns the file a job
ID number (10), sends it to color-seiko’s queue, and alerts lpsched (the spooler
that controls the flow of jobs out of the queue) that the file (job #10) is ready to be
printed. The printer’s queue displays job #10 in the local queue for color-seiko.

4. color-seiko is actually connected to another system on the network (mars)
where it is named seiko1. When job #10 reaches the top of color-seiko’s queue,
lpsched copies it across the network to the /usr/tmp directory on mars.

5. lp on mars makes a copy of job #10 in /var/spool/lp/request. It then assigns
it a new ID number (20) that doesn’t conflict with other IDs on mars, sends it to
seiko1’s queue, and alerts lpsched on mars that job #20 is ready to print. The
Printer Manager on mars shows job #20 in seiko1’s local queue; the Printer
Manager on saturn continues to show job #10 in color-seiko’s queue.

6. When job #20 reaches the top of the queue, lpsched sends the job over a cable to
seiko1.

7. seiko1 receives job #20 and prints out slide1 on paper or a transparency.

8. Job #10 disappears from color-seiko’s queue; job #20 disappears from seiko1’s
local queue. lpsched sends the next job in color-seiko’s local queue to mars.
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Where the Printing Process May Fail

This section shows how the printing process may fail at each step shown in
“Understanding the Printing Process”; it does not describe how to correct the failure. See
“A Troubleshooting Roadmap” on page 48 for a step-by-step approach to  isolate and
correct failures in the printing process.

1. When you ask an application to print a file on a certain printer:

• The file may go to a printer other than the one you expect because a hidden
default is set.

• You may specify a printer that’s not currently set up on your system.

• You may not actually complete the print request.

2. When the application or filter tries to create a new version of the file:

• There may not be enough memory or disk space in the system for the new file. If
this is the problem, you see an error message in the console window.

• The new file it creates may not be in the correct format for the printer (usually
due to missing filter software). You will not find out that this has happened
until the printer fails to print it. An error message appears in the
/var/spool/lp/log file.

3. When the application runs lp on the file:

• The printer may not be allowing new jobs to enter its queue, that is, “Printer
Accepting Your Jobs” is not chosen in the printer’s Queue menu.

• If lp tries to make a copy of the file in /var/spool/lp/request, there may
not be enough memory or disk space in the system for the new file. If this is the
problem, you see an error message in the console window.

• lp may not be able to find the printer you specified. If you typed in a printer
name that does not exist, lp cannot submit your job to that printer’s queue.

• The permissions on the file may not be set up to allow others to read it; in this
case lp cannot process it. If this is the problem, you see a message in the console
window saying permissions were denied.

4. When lpsched tries to copy the file to the remote system:

• If lpsched is not running, it cannot direct the file to a printer or remote system.
Typing lpstat -r determines whether lpsched is running.
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• The remote queue may already contain a job that came from your local queue.
lpsched on your system waits until the job that is already in the remote queue
disappears from that queue before it sends the next job.

• The printer may not be allowing jobs to exit from its queue, that is, “Printer
Printing Your Queued Jobs” is not chosen in the printer’s Queue menu.

• The network may be down.

• Your system may not be communicating with the network; for example, your
networking software is not working or your network cable is loose.

• The remote system may not be communicating with the network; for example,
it may be turned off.

• The remote system may not allow your system to use the printer. See Chapter 2,
“Printers” in the optional IRIX Admin: Peripheral Devices guide for information
on using the addclient command.

• The remote system may not have enough disk space to accept the file.

5. When lp on the remote system tries to process the file:

• When lp tries to make a copy of the file in /var/spool/lp/request, there
may not be enough memory or disk space in the remote system for the new file.

• The remote printer may not be allowing new jobs to enter its queue, that is,
“Printer Accepting Your Jobs” is not chosen in the printer’s Queue menu.

• The printer on the remote system may be gone or renamed. For example, if
someone changed the name of seiko1 to seiko2, lp on the remote system
cannot find seiko1. lp does not report this back to your system, so your job
remains in the local queue as if it were printing, but never appears in the remote
queue. lp does record the problem in the /var/spool/lp/log file on the
remote system.

6. When lpsched sends the job over the cable to the printer:

• If lpsched is not running, the file will never be directed to a printer. Use the
lpstat -r command on the remote (printing) system to check lpsched.

• The printer may not be allowing jobs to exit from its queue, that is, “Printer
Printing Your Queued Jobs” is not chosen in the printer’s Queue menu on the
remote (printing) system.

• The cable may be loose or disconnected.

• The cable may be broken or frayed.
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• The cable may not have the correct pinouts to match the printer or the system.

• The printer may be turned off.

7. When the printer receives the job and tries to print it:

• The printer may be jammed or out of supplies such as paper or toner.

• The printer may not have enough memory to print a complex job. In this case,
the printer’s status mechanism shows it is trying to print, but then the printer
gives up after a specified period of time, removes the job from the queue, and
prints nothing.

• The printer may not understand the format of the job because the application or
filter did not convert the file correctly. In this case, the printer’s status
mechanism never shows that it is trying to print, and the printer removes the
job from the queue but never prints it.

8. When jobs disappear from the queue:

• Jobs may disappear from the queue but never actually print as described above.

• Jobs may never disappear from the queue if the physical printer is not working
correctly.

• If jobs ahead of yours in the queue disappear, then jobs behind yours disappear
while yours remains at the top of the queue, there is something wrong with
your job; cancel it and try to print it again.

Troubleshooting Tools

When you troubleshoot printing problems using “A Troubleshooting Roadmap” on
page 48, you use a number of different tools and techniques. This section summarizes the
tools, and suggests other sources of information on isolating and correcting problems.

“Send Test Page”
This choice appears in the Printer menu in the Printer Manager window
and in each individual printer’s queue window. When you choose
“Send Test Page,” you run the lp command on a sample file that is
already in the correct format for that printer; in other words, you bypass
steps 1 and 2 of the printing process described in “Understanding the
Printing Process” on page 58.
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lpstat This IRIX™ command provides an alternate view of the queues that the
Printer Manager displays; it also reports whether lpsched is running.
To see a full lpstat listing that includes queues for every printer on the
system plus the status of lpsched, you would type: lpstat -t

/var/spool/lp/log
This file contains a history of all printing activity and errors. Its
messages are often difficult to understand, but you may find some
useful error information that you can use for troubleshooting. For
example, a “login incorrect” message that has a timestamp near a time
when your job could not reach a remote queue may make you suspect
that there is a password on the lp account on the remote system.

/etc/init.d/lp start
This IRIX command restarts the scheduler, lpsched.

Other documentation
Appendix A in the optional IRIX Admin: Peripheral Devices guide
contains a detailed table of printing error messages and Chapter 2
describes how to use the lp system from an IRIX shell; the lp reference
page gives a complete listing of all the command line options for lp.
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administrator

The person who can use the most privileged account, root. This person must have his or
her own personal login account for daily use, but, when there are serious system
problems to correct, the person logs in to the root account to change system information
using the graphical tools or using the IRIX shell.
The administrator has all the capabilities of a privileged user, plus the capability to
change information in the root account (such as the password) and to log into an IRIX
shell as root. Because there is only one root account, there is only one administrator per
system. The Information Panel for a particular system includes the name of the system’s
administrator so other users know who to contact for help.

ASCII text

An ASCII file contains text only. When you save a file as ASCII text, you save only the
characters, not the size, the font, the style, the color, or the format.

bits per pixel

8-bit color uses 8 bits to describe the intensity of each color channel. If a pixel is composed
of Red, Green and Blue (RGB) with 8 bits per color (3 color channels), you have 24-bit
color. 16 bits per color channel results in 48-bit color (again, for a pixel with 3 color
channels).

default printer

The printer to which the system directs a print request if you do not specify a printer
when you make the request. You set the default printer using the Printer Manager.

default scanner

The scanner from whichgscan automatically scans images unless you specify a different
scanner. You set the default scanner using the Scanner Manager.

driver

Software that lets a peripheral like a printer or scanner interact with your workstation or
server.
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generic printer

A generic printer is one that does not have drivers for Impressario software. You can set
only a few basic printing options for generic printers.

icon catalog

A window that contains pages for groups of your applications. To see your icon catalog,
choose “Applications” from the Find toolchest. Figure 1-1 shows a sample icon catalog.
Figure 1-2 shows a sample toolchest.

image source

The location of the image that you want to scan. The image can be located in a scanner,
in an image file, or on another system’s screen.

impressario printer

A printer that has pre-installed drivers in the Impressario software. These drivers let you
access all of the printer’s capabilities.

launch icon

An arrow-shaped icon that appears in the left margin of the IRIS InSight™ viewer and the
Help viewer. Double-click this icon to run an application.

local system

The workstation which you are currently using.

peripheral

A hardware device that adds more functionality to the basic workstation, such as a tape
drive.

PPD

Abbreviation for PostScript Printer Description. PPD files are human-readable text files
that describe the features of a specific PostScript capable printer. A PPD file describes
printer features in such a way that a graphical user interface (GUI) can be built to present
the user with a list of printer features to choose from. Impressario includes a PPD based
driver. See the ppd(1M) reference page for details.

prescan

To scan an image at a very low resolution and display it in gscan’s window. You use the
prescanned image to view and crop the image before scanning the final image.
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print server

A workstation or server that accepts and spools print jobs for a printer. The printer is
usually directly connected to the print server.

queue

A list of print jobs waiting to be printed on a particular printer. Also the space on a system
that spools the print jobs. Double-click a printer’s icon to see its queue. Use the Printer
Manager to add a printer and set options for its queue.

remote system, drive, disk, file system, or printer

A hardware device or the information or media it contains that you can access across the
network; they are not physically connected to your workstation.

resolution

The number of dots per inch (dpi) that an image contains. Screen resolution is the
number of pixels per inch that the screen can use to display an image. Printer resolution
is the number of dots of ink per inch that the printer can print. Scanner resolution is the
number of dots per inch of the image that the scanner can recognize. In general, if the
printing or scanning resolution is too low, image quality will suffer.

scanning destination

The location to which gscan should send the final scanned image. It can place the image
in an image file, display it on another system’s screen, or send the image directly to a
printer.

server

A system that other systems on the network access to use its disk space, software, or
services.

supported printers

Impressario software has drivers for its supported printers. See also impressario printer.

supported scanners

Impressario software has drivers for its supported scanners that let you access all of the
scanners features.

toolchest

The toolchest is found on your desktop. Use its menus to access various desktop tools.
See Figure 1-2 for a sample toolchest.




